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1 Introduction 

ProHawk® Vision (Release 6.0.0) 

The ProHawk® Vision Users Guide provides an overview for the ProHawk Vision Windows Application.  

We have tried to make this overview clear, easy to understand, and informative. We value the 

relationship that we have with our users and believe this guide will be valuable in expediting the setup. 

ProHawk Vision receives video from a recorded file, live RTP/RTSP camera stream, or a Milestone 

XProtect VMS Server to improve. ProHawk Vision provides various preset and detailed enhancement 

parameters that can be changed by accessing the Windows User Interface. Automatic and One-Click 

filter preset radio buttons assist users in clarifying challenging visual conditions. ProHawk Vision 

advanced filters settings allow users to adjust the ProHawk parameters individually. These are specific 

adjustments that may have an impact on details to be revealed.  

Once the video stream is selected, ProHawk Vision provides several options to view the original and/or 

improved picture or video: Improved; Original and improved picture or video side-by-side; Improved 

with original preview. 

The current video frame or picture can be saved to the Windows clipboard and users Pictures\ProHawk 

folder on both video ProHawk improved and original stream types. The ProHawk Vision Windows 

Application provides media player controls for video control and record capabilities. This allows users to 

Play, Pause, Forward, Rewind, Stop, or Record the input video. The improved video can also be recorded 

to a file for future use. 

This is the v6.0.0 release of ProHawk Vision. 
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2 System Requirements

Following are the systems requirements for ProHawk Vision to operate properly: 

• 64-bit Multicore CPU 

• 8GB RAM (16GB or more recommended) 

• MS-Windows 7 or MS-Windows 10 

• NVIDIA Quadro, Tesla, GRID, GeForce or RTX products with Kepler, Maxwell, Pascal, Turing, Volta 
or Ampere generation GPUs 

ProHawk Vision includes and requires the following external libraries, which will automatically install: 

• Microsoft Visual C++ 2015-2019 Redistributable (x64) runtime 

• Microsoft .NET Framework 4.8 Redistributable 

• NVIDIA CUDA 11.0 

• OpenCV 4.4.0 – OpenCV 4.4.0 and lower versions are licensed under the 3-clause BSD license. 

See license information at https://opencv.org/license/ 

• FFMPEG - This software uses libraries of FFmpeg licensed under the LGPLv2.1 

ProHawk Vision supports 64-bit (x64) architectures. ProHawk Vision does not support 32-bit (x86) 

architectures. 

 

https://opencv.org/license/
http://ffmpeg.org/
http://ffmpeg.org/
http://www.gnu.org/licenses/old-licenses/lgpl-2.1.html
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3 Directories & Files 

There will be several directories created after extracting the ProHawk Vision installation. The application 

root folder is placed into the destination folder chosen during installation, typically your user account 

folder\ProHawk\Vision. If you selected the Sample Videos component to install, the sample videos will 

be placed into your user accounts Videos folder.  

Listed below are the folders and their descriptions: 

Folder Description 

Vision A Vision folder containing ProHawk Vision and associated files. 

Vision\docs 
Documentation files: ProHawk Vision Users Guide.pdf and End 
User License Agreement.txt. 

Vision\logo Icon, image, and text files used by the ProHawk Vision. 

{USERPROFILE}\Videos\original A collection of sample unenhanced videos.  The unenhanced 
videos are the direct untouched source video files without any 
enhancement from ProHawk Vision. 

{USERPROFILE}\Videos\clarified A collection of the same footage as the unenhanced (original) 
videos after they have been enhanced by ProHawk Vision. 

ProHawk. InstantVisualClarity. 
Plugin 

A folder containing the ProHawk Vision Milestone XProtect Smart 
Client Plugin and associated files and folders to run. This is typically 
located off the C:\Program Files\Milestone\XProtect Smart 
Client\MIPPlugins directory 
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4 ProHawk Vision Application 

You can open and run ProHawk Vision by either clicking on the desktop shortcut, or the start menu item. 

(Figure 1)  

 

Figure 1 
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 Media Menu 

The Media menu provides four options to view live video streams or stored media files. The four Media 

menu options are: 

• Open File 

• Open Milestone VMS Stream 

• Open Network Stream 

• Open Recording Folder 

 

Figure 2 

This section of the ProHawk Vision Users Guide will describe the Media menu options above. (Figure 2) 
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 Open File 

To select a file to enhance in the application, click on the Media menu, then click on the Open File menu 
option to allow selection of the desired file. (Figure 3)  
 

 

Figure 3 
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Figure 3 

Select the file to enhance in the open file dialog box, then click on the Open button to load the desired 

file. (Figure 4) 

 

Figure 4 
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The file will load with a “File Preview loaded. Press Play to begin enhancement.” yellow message 

displayed in the lower left corner of the user interface. (Figure 5) Click on the Play button to begin 

ProHawk Vision enhancement on the file. 

 

Figure 5  
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 Open Milestone VMS Stream 

To select a live Milestone XProtect VMS video stream to view in the application, click on the Media menu, 
then click on the on the Open Milestone VMS Stream menu option. (Figure 6) 
 

 
Figure 6 

This will open the Open 

Media dialog box on the 

Milestone VMS tab. Select 

the Server address from 

the dropdown list or enter 

the Server address of the 

Milestone XProtect VMS 

Server. (Figure 7)  

Figure 7 
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Next, select the 

Authentication method for 

accessing the Milestone 

XProtect VMS Server. 

(Figure 8) If you choose 

Windows authentication 

(current user) click on the 

Connect button to submit 

the security credentials to 

the Milestone XProtect 

VMS Server. 

 

 

 

If you choose Windows 

authentication or Basic 

authentication, enter the 

User name and Password 

for your Milestone login 

credentials. Then click on 

the Connect button. 

(Figure 9)  

Figure 8 

Figure 9 
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 Open Network Stream 

To select a live video stream to view in the application, click on the Media menu, then click on the on 
the Open Network Stream option. (Figure 10) 
 

 
Figure 10 

The Network tab will be 

selected in the Open 

Media dialog box. In the 

Network Stream section, 

enter the URL, and if 

required, the Username 

and Password for the 

camera. Then click on the 

Connect button. (Figure 

11) 

Figure 11 
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The camera URLs that have been entered can be saved or deleted through the Save network URL and 

Delete network URL buttons. Selecting the Save network URL button will add the currently entered 

URL, Username, and Password to the list. Selecting the Delete Camera URL button will delete the 

currently entered URL address from the address bar and the list. The list of saved URLs can be accessed 

and reselected by clicking on the down arrow at the right end of the address bar.  

The camera live video stream will begin to play with ProHawk Vision restoration On. (Figure 12) Click on 

the Play button to begin ProHawk Vision enhancement on the file. 

 

Figure 12 
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 Open Recording Folder 

To Open a previously recorded ProHawk Vision restored file, click on the Media menu, then click on the 

Open Recording Folder menu option to allow selection of the desired file. (Figure 13) 

 

Figure 13 
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Figure 3 

Double-click on the restored ProHawk Vision file in the file selection dialog box to load the desired file. 

(Figure 14) 

 

Figure 14 
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 Edit Menu 

The Edit menu allows you to copy the current video frame or picture to the Windows clipboard and users 
Pictures\ProHawk folder on both video ProHawk enhanced and original stream types. Click on the Edit 
menu, Original or ProHawk menu options to copy the current original or ProHawk restored video frame 
as an image file. (Figure 15)  

Original – Saves the displayed source image to the user clipboard and Pictures\ProHawk folder. 

ProHawk – Saves the displayed enhanced image to the user clipboard and Pictures\ProHawk folder.  

This section of the ProHawk Vision Users Guide will describe the Edit menu options above. (Figure 15) 

  

Figure 15 
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 View Menu 

ProHawk Vision provides several viewing options accessible through the View menu (Figure 16). The 

available View menu options and their default View options settings are: 

• Advanced Filter Settings – Off 

• Expert Filter Settings 

• Enhanced View - On 

• Side-by-Side View - Off 

• External Enhanced View - Off 

• Unenhanced External View – Off 

 

Figure 16 

This section of the ProHawk Vision Users Guide will describe the View menu options above. (Figure 33) 
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 Advanced Filter Settings 

ProHawk Vision Advanced Filters Settings allows user to adjust the ProHawk parameters individually. To 

display and access the Advanced Filter Settings, click on the View menu, then click on the Advanced 

Filter Settings menu option (Figure 17).  

 

Figure 17 
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The Advanced Filter Settings section will be displayed that contains specific adjustments that may have 
an impact on details to be revealed. (Figure 18) Many times, when looking for specific details in 
compromised imagery or video, these parameters can be individually adjusted to achieve hidden details.  
The Advanced Filter Settings section contains these grouping and parameter adjustments:

• Noise Reduction 

o Sensitivity 

o Motion 

• Detailed Enhancement 

o Histogram 

o Tone Effect 

• Resolution 

o Sharpening 

• Contrast 

o Sensitivity 

o Brightness 

 

• GPU Capacity 

o Circle 

o Radius 

• Color Saturation 

o Saturation

 

Figure 18 
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 Expert Filter Settings 

ProHawk Vision Expert Filters Settings allows user to adjust the ProHawk detailed parameters 

individually. To display and access the Expert Filter Settings, click on the View menu, then click on the 

Expert Filter Settings menu option. (Figure 19) 

 

  

Figure 19 
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 Enhanced View 

The View menu Enhanced View menu option is turned On by default. (Figure 20) The Enhanced View 

menu option toggles the ProHawk Vision restoration filter On and Off. When the Enhanced View menu 

option is selected, it will toggle the Enhanced View menu option Off. 

 

Figure 20 
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 Side-by-Side View 

Once the video stream is selected, ProHawk Vision will simultaneously display both the original (source) 
stream on the left and the restored (enhanced) stream on the right. The example below shows how the 
user interface displays the imagery side-by-side. (Figure 21) 

 
Figure 21 
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 Enhanced External View 

ProHawk Vision provides the Enhanced External View, View menu option, to open a separate window 

with only that ProHawk Vision enhanced imagery displayed. Click on the Enhanced External View, View 

menu option. This will allow you to view a ProHawk Vision enhanced video stream in full screen mode. 

(Figure 22) 

 

Figure 22 

ProHawk Vision opens the Enhanced External View 

separate window with only the ProHawk Vision 

enhanced live video stream being displayed.        

(Figure 23)  

Figure 23 
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 Unenhanced External View 

ProHawk Vision provides the Unenhanced External View, View menu option, to open a separate window 

with only that original imagery displayed. Click on the Unenhanced External View, View menu option. 

This will allow you to view a ProHawk Vision original video stream in full screen mode. (Figure 24) 

 

Figure 24 

ProHawk Vision opens the Unenhanced External View 

separate window with only the original live video 

stream being displayed. (Figure 25)  

   

Figure 25 
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 Options Menu 

ProHawk Vision provides an Options menu to control enhancement, recording, voice commands, and 

default folders. The Options menu options and their default Options settings are: 

• Disable Enhancement – Enable/Disable 

• Enable 2X Enhancement – Disable/Enable 

• Auto Filter - Enable/Disable 

• Region of Interest – Zoom – 1-5 

• Create Side-by-Side View – On/Off 

• Audio Re-mux – Enable/Disable 

• Enable Frame Annotation – Disable/Enable 

• Enable Voice Commands - Disable/Enable 

• Set Default Image Source Directory – Desktop 

 

Figure 26 

This section of the ProHawk Vision Users Guide will describe the Options menu item options above. 

(Figure 26) 
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 Disable Enhancement 

ProHawk Vision defaults to the Disable Enhancement, Options menu being unselected. This sets the 

ProHawk Vision engine On. When the Disable Enhancement, Options menu is unselected, there will be 

no checkmark next to the menu option. (Figure 27) To turn the ProHawk Vision engine Off, click on the 

Disable Enhancement, Options menu choice.  

 

Figure 27 
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When the Disable Enhancement, Options menu is selected, it will display a checkmark next to the 

Disable Enhancement, Options menu choice. This sets the ProHawk Vision engine Off. (Figure 18) To 

turn the ProHawk Vision restoration engine On, click on the Disable Enhancement, Options menu 

choice. (Figure 28) 

 

Figure 28 

  



  

Page 30 of 87 
ProHawk Technology Group, Inc. 

ProHawk Vision v6.0.0 

 2x Enhancement 

ProHawk Vision defaults to the 2x Enhancement, Options menu being unselected. This sets the ProHawk 

Vision engine in a normal mode of operation. When the 2x Enhancement, Options menu is unselected, 

there will be no checkmark next to the menu option. (Figure 29) To run the imagery through the ProHawk 

Vision engine twice, click on the 2x Enhancement, Options menu choice.  

 

Figure 29 
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When the 2x Enhancement, Options menu is selected, it will display a checkmark next to the 2x 

Enhancement, Options menu choice. This sets the ProHawk Vision engine in a two-pass mode where the 

imagery is run twice through the ProHawk Vision engine. (Figure 30) To turn the ProHawk Vision two-

pass mode Off, click on the 2x Enhancement, Options menu choice. 

 

Figure 30 
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 Auto Filter 

AI based automatic filters enable the clearest imagery quickly, confidently, and efficiently. The 

automated computer vision filters provide clear video for systems to reach actionable results fast for a 

wide range of difficult live video environments.  ProHawk improves poor low- or high-resolution live 

video interpreted by operators or AI. Auto Filters, when turned ON, provide the best clear video results 

for all compromised real-world environments. Click on the Auto Filters menu item to turn Auto Filters 

ON. (Figure 31) When Auto Filters is turned ON, there will be a check mark next to the Auto Filter menu 

option. Notice the difference between the Presets Filter for Lowlight and the Auto Filter determining the 

best visibility based on the video frame between Figure 31 and Figure 32.  

 

Figure 31 

 
Figure 32 
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 Region of Interest 

The Region of Interest option provides functionality that focuses on a specific area in the image and 

zooms in on the images. To enable the Region of Interest function, select the Options menu, Region of 

Interest, Zoom and the associated zoom in value. (Figure 33) 

 

Figure 33 
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The example below shows the Region of Interest that is currently selected, and the zoom value is 3, 

which will zoom in and expand the pixels by 300% in the image. (Figure 34) 

 

Figure 34 
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 Set DPI 

The Set DPI option allows output images to be formatted to the appropriate dots per inch setting for 

publishing applications. (Figure 35) 

 

Figure 35 
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 Create Side-by-Side 

ProHawk Vision provides a Create Side-by-Side, Options menu being unselected. This sets the ProHawk 

Vision engine recording mode in a side-by-side output of the original and ProHawk Vision streams. When 

the Create Side-by-Side, Option menu is unselected, there will be no checkmark next to the menu 

option. (Figure 36) To create side-by-side recording files, click on the Create Side-by-Side, Options menu 

choice.  

 

Figure 36 
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When the Create Side-by-Side, Options menu is selected, it will display a checkmark next to the Create 

Side-by-Side, Options menu choice. This sets the ProHawk Vision recorder in a side-by-side output mode 

where the original and ProHawk Vision imagery are recorded together. (Figure 37) To turn the side-by-

side output mode Off, click on the Create Side-by-Side, Options menu choice. 

 

Figure 37 

  

v 
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 Audio Re-mux 

ProHawk Vision handles audio tracks in video files through its Enable Audio Re-mux, Options menu 

choices. (Figure 38) There are two Enable Audio Re-mux, Options menu choices: Re-mux Enhanced File, 

and Re-mux side-by-side File. Audio tracks can be passed through to the ProHawk Vision enhanced 

output recording when the Re-mux Enhanced File, Options menu choice is selected.  Audio tracks can 

be passed through to the ProHawk Vision side-by-side output recording when the Re-mux side-by-side 

File, Options menu choice is selected. 

 

Figure 38 
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When the Audio Re-mux, Options menu Re-mux Enhanced File menu choice is selected, it will display a 

checkmark next to the Audio Re-mux, Options menu Re-mux Enhanced File menu choice. This sets the 

ProHawk Vision output mode to include audio from the original source and re-mux it back together in 

the ProHawk Vision enhanced recorded file. To turn the audio re-mux output mode Off, click on the 

Audio Re-mux, Options menu Re-mux Enhanced File menu choice. (Figure 39) 

 

Figure 39 
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When the Audio Re-mux, Options menu Re-mux Side-by-Side File menu choice is selected, it will display 

a checkmark next to the Audio Re-mux, Options menu Re-mux Side-by-Side File menu choice. This sets 

the ProHawk Vision output mode to include audio from the original source and re-mux it back together 

in the ProHawk Vision side-by-side output recorded file. To turn the audio re-mux output mode Off, click 

on the Audio Re-mux, Options menu Re-mux Side-by-Side File menu choice. (Figure 40) 

 

Figure 40 
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  Frame Annotation 

ProHawk Vision provides a feature to attached annotated notes to a frame of video or image. To activate 

the annotation capability, click on the Frame Annotation, Options menu choice. (Figure 41) 

 

Figure 41 
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Notice the Frame Annotation section appears next to the ProHawk logo in the lower left corner if the 

ProHawk Vision user interface. (Figure 42) There are three options for Frame Annotation: Note Text, 

Note Color, and Frame Number Color. Enter the text into the Enter Text box, select the Note Color, 

select the Frame Number Color, and click Record Annotation button to attach it to a frame or image. 

 

Figure 42 
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  Voice Commands 

ProHawk Vision can be controlled by voice commands. To activate voice commands, click on the Voice 

Command, Options menu choice. There are a total of 53 voice commands to control ProHawk Vision 

hands-free. The current Voice Command list can be found under the Help menu, Voice Command List 

menu option. (Figure 43) 

 

Figure 43 
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When the Voice Commands, Options menu choice is selected, a voice message through your audio 

speakers will indicate “Voice Command Enabled”. This will indicate that the voice command capabilities 

have been activated. (Figure 44) 

 

Figure 44 
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 Set Default Image Source Directory 

ProHawk Vision allows for the directory to be set for source file input. To set the default folder, click on 

the Set Default Image Source Directory, Options menu choice. (Figure 45) 

 

Figure 45 

This will open the Set Default Directory dialog box. Enter or select the directory and click on the Save 

button. (Figure 46) 

 

Figure 46 
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 Detect Menu 

The Detect menu controls the Object Detection and Tracking function of ProHawk Vision. (Figure 47) 

The Detect menu options and their default settings are: 

Enable – Off 

Object Detection and Tracking 

- Agriculture - Unselected 

- Insurance - Unselected 

- Retail - Unselected 

- Security - Unselected 

- Transportation - Unselected 

- Weapons - Unselected 

Configuration 

- Detection Confidence Score - 30 

- Full Detection Dataset - Off 

Figure 47 

This section of the ProHawk Vision Users Guide will describe the Detect menu options above. (Figure 47) 
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 Enable 

The Detect menu, Enable menu option turns Object Detection and Tracking function On and Off. 

ProHawk Vision defaults Object Detection and Tracking Off. To activate Object Detection and Tracking, 

click on the Enable menu option. (Figure 48)  

 

Figure 48 
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 Object Detection and Tracking 

Once Detect has been Enabled, the Object Detection and Tracking menu option will become accessible. 

ProHawk Vision will only monitor the object that you select. To select an object, click on the Detect 

menu, and click on the Object Detection and Tracking menu option. Next, select the category choice 

from the Object Detection and Tracking menu option list: Agriculture; Insurance, Retail, Security, or 

Transportation. Finally, select the specific object that you want ProHawk Vision to detect and track. 

(Figure 49) 

 

Figure 49 
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4.5.2.1 Agriculture 

Once the Object Detection and Tracking menu option is accessible, the Agriculture menu option will be 
available. ProHawk Vision will only monitor the Agriculture object(s) that you select. To select an 
Agriculture object, click on the Detect menu, and click on the Object Detection and Tracking menu 
option. Next, select the Agriculture category from the Object Detection and Tracking menu option list. 
The available objects to detect and track in the Agriculture category that you can select include: Apple; 
Banana; Broccoli, Carrot, Cow, Orange, and Sheep. (Figure 45) This limited list can be extended by a 
trained expanded dataset.  

 

Figure 50 
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4.5.2.2 Insurance 

Once the Object Detection and Tracking menu option is accessible, the Insurance menu option will be 
available. ProHawk Vision will only monitor the Insurance object(s) that you select. To select an 
Insurance object, click on the Detect menu, and click on the Object Detection and Tracking menu option. 
Next, select the Insurance category from the Object Detection and Tracking menu option list. The 
available objects to detect and track in the Insurance category that you can select include: Bed; Bench; 
Book, Chair, Cell Phone, Clock, Dining Table, Sofa, Keyboard, Microwave, Mouse, Potted Plan, 
Refrigerator, Remote, Sink, Toaster, Toilet, Oven, TV Monitor, and Vase. (Figure 46) This limited list can 
be extended by a trained expanded dataset.  

 

Figure 51 
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4.5.2.3 Retail 

Once the Object Detection and Tracking menu option is accessible, the Retail menu option will be 
available. ProHawk Vision will only monitor the Retail object(s) that you select. To select a Retail object, 
click on the Detect menu, and click on the Object Detection and Tracking menu option. Next, select the 
Retail category from the Object Detection and Tracking menu option list. The available objects to detect 
and track in the Retail category that you can select include: Baseball Bat; Baseball Glove; Bowl, Cake, 
Cup, Donut, Frisbee, Hot Dog, Kite, Pizza, Sandwich, Skateboard, Skis, Snowboard, Sprots Ball, Tennis 
Racket, Tie, and Wine Glass. (Figure 47) This limited list can be extended by a trained expanded dataset.  

 

Figure 52 
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4.5.2.4 Security 

Once the Object Detection and Tracking menu option is accessible, the Security menu option will be 
available. ProHawk Vision will only monitor the Security object(s) that you select. To select a Security 
object, click on the Detect menu, and click on the Object Detection and Tracking menu option. Next, 
select the Security category from the Object Detection and Tracking menu option list. The available 
objects to detect and track in the Security category that you can select include: Backpack; Bear; Bird, 
Bottle, Cat, Dog, Fork, Handbag, Horse, Knife, Person, Scissors, Spoon, Suitcase, and Umbrella. (Figure 
48) This limited list can be extended by a trained expanded dataset.  

 

Figure 53 
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4.5.2.5 Transportation 

Once the Object Detection and Tracking menu option is accessible, the Transportation menu option will 
be available. ProHawk Vision will only monitor the Transportation object(s) that you select. To select a 
Transportation object, click on the Detect menu, and click on the Object Detection and Tracking menu 
option. Next, select the Transportation category from the Object Detection and Tracking menu option 
list. The available objects to detect and track in the Transportation category that you can select include: 
Bicycle; Boat; Bus, Cars, Fire Hydrant, Motorcycle, Parking Meter, Stop Sign, Traffic Light, Train, and 
Truck. (Figure 49) This limited list can be extended by a trained expanded dataset.  

 

Figure 54 
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 Configuration 

Once Detect has been Enabled, the Configuration menu option will become accessible. (Figure 50) 

ProHawk Vision allows you to control the Detection Confidence Score for operation. This provides the 

object percentage confidence for recognition to be set within the detection system when monitoring the 

object(s) that you selected. ProHawk Vision also provides a Full Detection Dataset menu option, that 

enables a larger number of convolutional layers in the Yolo/Coco dataset for the deep neural network 

to process to identify objects. This results in a much higher level of recognition, detection, and tracking, 

but requires additional computational resources. 

 

Figure 55 
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4.5.3.1 Detection Confidence Score 

To set the Detection Confidence Score for object(s), click on the Detect menu, and click on the 

Configuration menu option. Next, select the Detection Confidence Score menu option. Finally, select 

the Detection Confidence Score you want for detection from the dropdown list, or enter the number 

you desire. (Figure 56) 

 

Figure 56 
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4.5.3.2 Full Detection Dataset 

To Enable the Full Detection Dataset for Yolo/Coco deep neural network operation, click on the Detect 

menu, and click on the Configuration menu option. Next, click the Full Detection Dataset menu option. 

(Figure 57)  

 

Figure 57 
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4.5.3.3 CPU 

To use the systems CPU for Yolo/Coco deep neural network operation processing, click on the Detect 

menu, and click on the Configuration menu option. Next, click the CPU menu option. (Figure 58) 

 

Figure 58 
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4.5.3.4 GPU 

To use the systems GPU (recommend setting) for Yolo/Coco deep neural network operation processing, 

click on the Detect menu, and click on the Configuration menu option. Next, click the GPU menu option. 

(Figure 59)  

 

Figure 59 
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 Notifications and Alerts 

The Configuration menu has an option to setup Notifications and Alerts on Object Detection and 

Tracking. ProHawk Vision allows you to setup Email alerts based on Object Detection and Tracking and 

associated Detection Confidence Score to trigger the alert. Click on the Configuration menu, the click 

on the Notifications and Alerts menu option to open the Alerts and Notifications Settings dialog box. 

(Figure 60) 

 

Figure 60 
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The Alerts and Notifications Settings dialog box allows 

you to setup Email Notification Server settings. To 

Enable Email Notifications click on the Enable Email 

Notifications checkbox after you have filled out all the 

information in the Alerts and Notifications Settings 

dialog box. (Figure 61) 

 

 

 

 

 

The first step is to setup the Email Notification Server 

settings information (Figure 62), that includes the 

information required to setup the Email Notification 

Server: 

• SMTP Server Address 

• Enable SSL 

• Sender 

• Password 

• Recipients 

• Subject 

 

  

Figure 61 

Figure 62 
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Once you have entered the configuration information 

for the Email Notification Server, you can test the setup 

using the Test Email button. To test the Email 

Notification Server settings, click on the Test Email 

button. (Figure 63)  

 

 

 

 

 

 

Once the Email Notification Server is configured and 

working, you will need to setup the Object and 

Confidence Selection including the Object Name to 

recognize and detect and the desired Confidence Level. 

(Figure 64) 

  

Figure 63 

Figure 64 



  

Page 62 of 87 
ProHawk Technology Group, Inc. 

ProHawk Vision v6.0.0 

To select an Object Name, click on the Object Name 

dropdown menu. (Figure 65) 

 

 

 

 

 

 

 

 

This will dropdown the list of Object Names that you can 

select to monitor with an Email Notification. Scroll 

through the list and click on the Object Name that you 

want ProHawk Vision to monitor. In the example to the 

right, the Object Name Person is selected. (Figure 66) 

Figure 65 

Figure 66 
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Once the Object Name has been selected, in this 

example Person, then the Confidence Level needs to be 

set. The Confidence Level is the percentage certainty 

ProHawk Vision has on Object Detection and Tracking. 

To set the Confidence Level, click on the Confidence 

Level dropdown menu. (Figure 67)  

 

 

 

 

 

This will dropdown the list of Confidence Levels that you 

can select to monitor the Object Name that was 

selected. Scroll through the list and click on the 

Confidence Level that you want ProHawk Vision to use 

as the threshold to monitor for Email Notifications. In 

the example to the right, 80 is selected as the 

percentage threshold to trigger an Email Notification. 

(Figure 68)  

  

Figure 67 

Figure 68 
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Once the Confidence Level has been set for the Object 

Name to monitor, 80 in the example, for Email 

Notification, to finalize the monitoring, click on the Add 

to Message button. (Figure 69) 

 

 

 

 

 

 

This will add the Object and Confidence Selection to the 

Object Notification List. The Object Notification List 

contains the individual Object and Confidence 

selections that were added to the Object Notification 

List. Both the Object Name:Confidence Level are 

displayed in the Object Notification List to uniquely 

identify the Email Notification settings for ProHawk 

Vision to monitor. (Figure 70)  

Figure 69 

Figure 70 
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To add the image that triggers an Email Notification, 

click on the Include Image checkbox to the right of the 

Object Notification List. This will add the image that 

triggered the Email Notification into the body of the 

email message. (Figure 71)  

 

 

 

 

 

 

To Save the Alerts and Notification Settings, click on the 

Save button in the lower right hand corner of the Alerts 

and Notifications Settings dialog box. This will Save the 

Alerts and Notifications Settings in ProHawk Vision. 

(Figure 72) 

  

Figure 71 

Figure 72 
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To Delete item(s) on the Object Notification List, first 

click on the Object(s) that you want to Delete in the 

Object Notification List. (Figure 73) 

 

 

 

 

 

 

 

This will select the Object(s) indicated by a blue highlight 

bar. To remove the Object(s) from the Object 

Notification List, click on the Delete button. (Figure 74) 

  

Figure 73 

Figure 74 
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To Clear All the information that is filled in the Alerts 

and Notifications Settings dialog box, click on the Clear 

All button. (Figure 75) 

 

 

 

 

 

 

 

This will remove all the information that has been filled out 

in the Alerts and Notification Settings dialog box fields. 

(Figure 76) 

  

Figure 75 

Figure 76 
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 About Menu 

The ProHawk Vision application provides an About menu that provides access to license key information. 

(Figure 77)  

 

 

The license key information that is display in the dialog box is the 

expiration date of the license. (Figure 78) 

  

Figure 78 

Figure 77 
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 Control Section 

The ProHawk Vision Application provides a Control Section with media player controls for video control 

and record capabilities. This allows users to Play, Pause, Forward, Rewind, Stop, or Record video streams. 

Click on the Control buttons to manipulate the video. (Figure 79) 

 

Figure 79 

• Forward/Rewind slider – Forwards or Rewinds the current video by time. 

• Play – Plays the currently loaded video 

• Pause – Pauses the video being played 

• >> – Forwards the current video by frames 

• << – Rewinds the current video by frames 

• Stop – Stops and terminates the video enhancement 

• Record – Record control for the video 

  

Commented [BB1]:  
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 Record Clarified Video 

The current video stream can be recorded and stored. Click the Record button to start and stop 

recording. (Figure 80) 

 

Figure 80 

When the enhancement process is completed, the following dialog will prompt if you want to open the 

location of the file. If you wish to view the folder that contains the recorded video, click on the Yes 

button. (Figure 81) 

 
Figure 81 

  



  

Page 71 of 87 
ProHawk Technology Group, Inc. 

ProHawk Vision v6.0.0 

Below shows the location of the recorded enhanced video that the system produced. The default storage 
location is the installed users Videos folder. (Figure 82) 

 

Figure 82 
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 Progress Section 

The ProHawk Vision Application provides a Progress Section with several progress status indicator 

metrics. (Figure 83) The progress status metrics include:  

• Progress Bar 

o % progress 

o Begin timestamp 

o End timestamp 

• Frame # - Current frame count number of the video 

• Bytes – Total bytes process of the video 

  

Figure 83 
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 Media Information Section 

The ProHawk Vision Application provides a Media Information Section containing metadata information 

about the video. (Figure 84) The metadata information about a video stream or file includes: 

• Media Source – Name of the source of the video 

• Creation Date/Time – The date and time the video was created 

• Resolution – The video number of distinct pixels in each dimension, typically width x height 

• FPS – Frames per second of the video 

• Duration – Length of time of the video 

• File Size – Storage size of the video 

• Frame Count – Number of frames in the video 

• Bits/Pixel – Number of bits of information to represent the color channels of each pixel 

  

Figure 84 
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 Performance Section 

The ProHawk Vision Application provides a Performance Section containing metadata information about 

the video. (Figure 85) The performance information about a video stream includes: 

• Frame Process Time (ms) – The time, in milliseconds, for the application to process and render 

video in the GUI 

• Frame Tx Rate (ms) – The time, in milliseconds, for the application to transfer a frame of video 

• Enhanced Pixels/Second (MP) – The number of Megapixels process in 1 second 

• Rendered Pixels/Second (MP) – The number of Megapixels rendered in the GUI in 1 second 

Located above the Performance Section is a performance gauge for the underlying ProHawk Vision 

engine. The performance gauge displays the throughput of the ProHawk Vision engine in milliseconds 

(ms). 

  

Figure 85 
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 Filter Presets Section 

The ProHawk Vision Application provides a Filter Presets Section containing one click preset adjustments 
for problematic video. Filter Presets radio buttons assist users in clarifying challenging visual conditions. 
(Figure 86) 

The problem conditions include: 

• BACKLIGHT 

• DIRT 

• FOG 

• HEADLIGHT 

• INFRARED 

• LOWLIGHT 

• NIGHT 

• RAIN 

• SAND 

• STANDARD 

• SNOW 

• SMOKE 

• SUNGLARE 

• UNDERWATER 

• WINDOW TINT 

  

  

Figure 86 
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 Custom Presets Section 

The ProHawk Vision Application provides a Custom Presets Section containing controls to save, select, 

and delete your own Custom Preset filters. (Figure 87) Custom Presets controls include: 

• Select Custom Filter – Choosing the custom filter saved to use 

• Delete – Remove a custom filter created 

• Save – Enter a new customer filter name and save it with the current advanced filter settings 

 

 Advanced Filter Setting Section 

The Advanced Filter Settings section will be displayed that contains specific adjustments that may have 
an impact on details to be revealed. (Figure 88) Many times, when looking for specific details in 
compromised imagery or video, these parameters can be individually adjusted to achieve hidden details.  
The Advanced Filter Settings section contains these grouping and parameter adjustments:

• Noise Reduction 

o Sensitivity 

o Motion 

• Detailed Enhancement 

o Histogram 

o Tone Effect 

• Resolution 

o Sharpening 

• Contrast 

o Sensitivity 

o Brightness 

 

• GPU Capacity 

o Circle 

o Radius 

• Color Saturation 

o Saturation

Figure 87 



 

 Noise Reduction 

The Noise Reduction parameters reduce or remove noise from compromised video. Examples of 

problem environment conditions that require extensive Noise Reduction include: Rain, Smoke, Snow, 

Dirt, Sand, and Underwater. (Figure 88)  

 

4.13.1.1 Sensitivity 

Noise Reduction Sensitivity adjusts the ratio/percentage brightness information for combining the 
ProHawk Vision processed image and histogram image. The parameter adjusts/sets the ratio versus the 
histogram, the larger the number, the more impact the histogram produces on the result. Specifies 
parameters for accumulating processed images and reducing noise. When set to 0, it will adjust the 
ProHawk Vision processed image 100%. The Noise Reduction Sensitivity parameter defaults to 0. Range: 
0-256 
 

4.13.1.2 Motion 

The Noise Reduction Motion parameter adjusts the level of residual image reduction effect due to 
movement compensation.  This is a threshold to recognize an object as a moving pixel(s).  When the 
setting is lower, ProHawk Vision becomes more sensitive to changes and residual image is reduced, but 
with less noise elimination effect.  When the setting is higher, it would become less sensitive, and with 
more noise elimination effect, yet residual image would become more noticeable. Specify parameters 
for reducing noise by adapting to the motion of the image.  
 
In most conditions, setting ProHawk Vision between 1024-3072 works well. On a fixed camera/sensor, 
decrease ProHawk Vision to detect moving objects, and increase Noise Reduction Sensitivity. The Noise 

Figure 88 
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Reduction Motion should always be ON if Noise Reduction Sensitivity is ON under normal 
circumstances. The setting of Noise Reduction Sensitivity ON and Motion is OFF should be used only 

when it is desired to remove the movements of snow or rain, etc. using a fixed camera. Range: 0-256. 

 

 Detailed Enhancement 

The Detailed Enhancement parameters for ProHawk Vision enable fine tuning and revealing details in 

hidden areas of video. Examples of problem environment conditions that require Detailed Enhancement 

include almost every situation. (Figure 89)  

 

4.13.2.1 Histogram 

Detailed Enhancement Histogram adjusts the ratio/percentage for combining the input image and 
histogram image. The Detailed Enhancement Histogram parameter adjusts the level of ProHawk Vision 
enhancement effect.  Images and video are improved in low contrast situations such as fog, rain, or 
snow, and in situations of too much contrast such as backlight or direct sunlight, or in darkness at night. 
The higher the setting is, the clearer the contrast will become, but the noise may also increase.  This 
parameter specifies the Detailed Enhancement Histogram between the original image and the processed 
image. Set it at 128 (50%) under normal circumstances. When set to 256, the image is processed by the 
ProHawk Vision 100%. The Detailed Enhancement Histogram defaults to 0. Range: 0-256. 

Figure 89 
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4.13.2.2 Tone Effect 

The Detailed Enhancement Tone Effect parameter expands the luminance range of ProHawk Vision. The 
Detailed Enhancement Tone Effect is for adjusting the contrast of the Tone Effect. It is available if the 
Contrast Brightness parameter is turned OFF.  
 
Set the Detailed Enhancement Tone Effect to 0 under normal conditions, gradually increase it until 
optimal results achieved. When the setting is high, it may cause fuzzy outlines to appear more noticeable 
on top of buildings into the sky. When it is set low to 0, it does not expand the luminance range. When 
it is set high to 256, it will expand the luminance range to the maximum capacity of ProHawk Vision. 
Range: 0-256. 
 

 Resolution 

The Resolution parameter setting controls how the ProHawk Vision will process video according to the 

resolution of the source device or desired sharpening enhancement results for object detection and 

tracking. (Figure 90) 

 

 
Figure 90 

4.13.3.1 Sharpening 

Sharpening specifies the range to be referred to from the pixel to be processed in radius (pixel). 
Sharpening considers the width and height of the radius of processing range of the ProHawk Vision. 
The smaller the setting is, the clearer the contrast for details will become, but it will result in a 
painting-like image as the contrast for the entire screen is averaged.  Generally, set it low to 
emphasize small parts and fine details, or high if natural image quality is desired, or when there is 
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too much noise.  Set it in the middle under normal circumstances for a 1080p video. Set it lower 
between 20-30 for SD 480p-720p video. Set it higher between 128-256 for UHD 4K-8K video. Set 
higher to increase edge sharpening for computer vision and analytics applications.  
Range: 1-256 
 

 Contrast 

The Contrast parameters provide for adjustment to the contrast of the ProHawk Vision. Examples of 

problem environment conditions that require extensive Noise Reduction include: Rain, Smoke, 

Snow, Dirt, Sand, and Underwater. (Figure 91) 

 

 

4.13.4.1 Sensitivity 

Contrast Sensitivity limits the luminance range of the ProHawk Vision. Set to a lower number reduces 

the level of residual image effect due to movement compensation.  This is a threshold to recognize 

an object as a moving pixel(s).  The Contrast Sensitivity parameter defines the distance allowance 

between the adjacent pixels (for example, luminance 10 and luminance 11 becomes luminance 15 

by ProHawk Vision…the distance 5 is calculated from the luminance 10) limiting the slope of the 

brightness fluctuation amount. This parameter allows for local contrast adjustments to the imagery 

enabling higher contrast viewing. Set it at 16 under normal circumstances.  

Decrease the Contrast Sensitivity value if random noise is noticeable in the video. When the Contrast 

Sensitivity setting is lower, ProHawk Vision becomes more sensitive to changes and residual image 

Figure 91 
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is reduced, but with less noise elimination effect.  Raise the Contrast Sensitivity setting higher to 

obtain better contrast or if contrast is insufficient. If the video is dark, the setting should be turned 

higher. When the setting is higher, ProHawk Vision becomes less sensitive, and with more noise 

elimination effect, yet residual image would become more noticeable. If it is dark and noise is 

conspicuous, reduce the Contrast Sensitivity to between 8 to 12, while also increasing the Contrast 

Brightness. When the Contrast Sensitivity is set to 256, the Histogram Tone Effect enhancement is 

turned OFF, Contrast Brightness and Detailed Enhancement Tone Effect are disabled. Range: 1-256 

 

4.13.4.2 Brightness 

Contrast Brightness changes the luminance range of ProHawk Vision. Contrast Brightness is for 
automatically adjusting the brightness of the tone effect according to the screen area. In typical use 
cases unless there is conspicuous noise, set the Contrast Brightness to automatic by selecting the 
Auto checkbox that overrides the Contrast Brightness slider bar. Specify parameters for brightness 
adjustment. When Auto is checked, brightness adjustment is done automatically. 
 
When Contrast Brightness is ON and Contrast Sensitivity is set low for dark video that is noisy, the 
entire screen is adjusted by a fixed brightness. When Contrast Brightness is set in the middle to 128, 
ProHawk Vision will adjust brightness by 50%. Range: 0-256 
 

 GPU Capacity 

The GPU Capacity parameters provide adjustment for optimal operation tuned to the capacity, 

throughout, and performance of the NVIDIA GPU being used. (Figure 92)

 
Figure 92 
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4.13.5.1 Circle 

GPU Capacity Circle is the number of divisions of circles in the processing range. Specify how many 

divisions are to be referenced from the processing target pixel to the radius specified by Radius. The 

number of divisions and processing time are proportional. Typically, 8 is the optimal setting, but in 

some cases where the video has many 45-degree lines, the image quality can be improved by setting 

to an odd number. Range: 3-16 

 

4.13.5.2 Radius 

Radius is the number of divisions of radius of processing range of ProHawk Vision. When referring to 

the pixel to be processed, it specifies how many surroundings to divide. The number of divisions and 

processing time are proportional. Range: 1-16 

 

 Color Saturation 

The Color Saturation parameter reveals vivid color in dark video scenes. (Figure 93)  

 

4.13.6.1 Saturation 

Saturation changes the magnification of color adjustment in ProHawk Vision. The Color Saturation 
parameter adjusts the level of ProHawk Vision color correction effect. Turn the Color Adjustment 
Saturation ON under normal circumstances with slight color correction. 
 

Figure 93 
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It may be turned OFF if it becomes difficult to see the image with color enhancement when the entire 
screen has color such as being in the ocean, etc. Set it higher temporarily to check color only when it 
is difficult to recognize color in video due to a dark video or a foggy video. Specify parameters for 
emphasizing color information that tends to be lost due to sharpening. The Color Saturation 
parameter defaults to 0. Range: 0-512 
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Figure 95 

5 License Key Update 

The ProHawk Vision License Key Update program allows you to 

upgrade and update your license key. To access the ProHawk Vision 

License Key Update program, click on the ProHawk Vision License Key 

Update, Start Menu option. This will run the ProHawk Vision License 

Key Update application. (Figure 94) 

 License Key 

Enter the 25-character license key, then click the Next > button. (Figure 
95) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Product Registration 

Fill in the registration information form, 

then click the Next > button to complete. 

(Figure 96) 

Figure 94 

Figure 96 
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6 Uninstaller 

This section covers the removal of ProHawk Vision from your computer. 
 

 Initiate Uninstaller 

To begin the uninstaller, go to your Windows Settings/Apps & features. Select the ProHawk Vision 
v5.0.0. Then click on the Uninstall button. (Figure 97) 
 

  

Figure 97 

You will be prompted by Windows “This app and its related info will be uninstalled.” Click on the 

Uninstall button. (Figure 98) 

 

Figure 98 
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 Confirm Uninstall 

To confirm uninstall, click the Yes button when prompted. Click the No button to cancel. (Figure 98) 

  

Figure 98 

 Uninstalling 

A progress dialog will appear after confirming to uninstall, wait for it to finish running. If you wish to end 
the uninstallation at any time you may click the Close or Cancel button. (Figure 100) 

 

Figure 100 
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 Configuration Information Removal 

The uninstaller prompt with a dialog to ask you if you want to completely remove the ProHawk Vision 
Server configuration information.  Click Yes to remove the configuration information or Click No to 
preserve the configuration information. (Figure 101) 

 

Figure 101 

 

 Finished Uninstalling 

When the uninstaller is finished a dialog will tell you that ProHawk Vision Application has been 
successfully removed from your system.  Click OK to finish the uninstallation. (Figure 102) 
 

  

Figure 102 

 


